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Audio interface and control surface

This section explains how to connect the unit with a computer and how to set up and
use the audio interface and control surface functions of the R& with a DAW and other
software.

Functions of the audio interface and control surface

INPUT jacks PHONES jack o o OUTPUT jacks
Guitars and other Playback device like Stereo system,
musical instruments, headphones or an speakers with built-in
built-in stereo mic # audio system amplifiers, etc.

R8 |
- |o @ _ Windows/Mac
S

USB Cable

DAW software

Cubase LE, etc.

Audio driver

[l Audio interface [l Control surface functions

The R& inputs and outputs can be used Control surface functions can be used
as a Hi-Speed USB 2.0 audio interface to control DAW software on a computer
with 2 inputs and 2 outputs at quality via USB. Transport operations, including
up to 24-bit/96kHz. Effects can be used playback, recording and stopping, and
when the sampling rate is 44.1 kHz, and physical control of the DAW faders are
the unit can be powered by a computer’s possible. Furthermore, various other DAW
USB bus. software functions can be mapped to the

F1~F5 keys (assignable functions depend
on the DAW used).
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Il Supports input from a variety of
sources, including guitars, mics and
line level instruments

The two onboard jacks include one high-
impedance input. Both accept XLR and
standard phone plugs and can provide
phantom power (24 or 48V).

Many sources are supported from high-
impedance guitars and basses to dynamic
and condenser microphones and line-
level devices like synthesizers. In addition,
the built-in high-performance condenser
microphones are convenient for recording
acoustic guitars and vocals.

[l Versatile effect functions

Built-in insert effects can be applied to
specific channel paths, and two-types
of send/return effects work via the mixer
send/return. These effects can be applied
when recording, of course, but they can
also be applied to only the monitor output.
For example, when recording vocals, you
can apply reverb only to the monitor signal
to make singing easier.

[l Comprehensive built-in mixer

Using the R& mixer, you can make a
mix for monitoring. When simultaneously
recording guitar and vocals, for example,
you can adjust volume balance, panning
and reverb levels.

Moreover, you can also adjust the balance
between the built-in mixer and the sound
sent from a computer.

B Multifunction tuner

In addition to standard chromatic tuning,
the on-board multifunction tuner also sup-
ports 7-string guitar, 5-string bass and
various drop tunings.




R& audio interface system requirements

R8 audio interface
system requirements

Windows

Windows® 7 (32-bit, 64-bit) or later

32-bit: Intel® Pentium® 4 1.8 GHz or faster

64-bit: Intel® Pentium® Dual Core 2.7 GHz or faster
32-bit: RAM 1 GB or faster

64-bit: RAM 2 GB or faster

Intel Mac

OS X 10.9 or later

Intel® Core Duo 1.83 GHz or faster
RAM 1 GB or faster

Both
USB 2.0 compatible port

+ USB hubs are not supported.
Intel® chipsets recommended.

Note about descriptions and images

This manual was prepared based on use with
Windows systems. Special functions related to Mac
OS X are indicated separately.

The screen images are of the Windows version of
Cubase LE.

About trademarks

Cubase LE Startup guide

Please refer to the Cubase LE Startup Guide
for detailed instructions on installing the ZOOM
R& audio driver and Cubase LE.

+The SD s and SDHC logos are trademarks.

» Windows® and Windows 7® are registered trademarks of Microsoft® in the USA.

» Macintosh® and Mac OS® are trademarks of Apple Inc.

+ Steinberg and Cubase are registered trademarks of Steinberg Media Technologies GmbH.

* Intel® and Pentium® are trademarks of Intel Corporation.

» Mackie Control is a registered trademark of LOUD Technologies.
« All other product names, registered trademarks, and company names mentioned in this documentation

are the property of their respective owners.

In order to improve the product, specifications might be changed without advance notice.
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Connecting and disconnecting in audio interface mode

This is an overview of connecting and disconnecting the R& to a computer with a USB
cable. For details, see the included “Cubase LE Startup Guide”.

Connecting the R8 to a computer
for the first time

‘I Install the Cubase LE DAW
software on the computer.

2 Install the ZOOM R& audio driver
on the computer from the included
SD card. (No driver is necessary for
use with Macintosh computers.)

[II% Reference: "Cubase LE Startup Guide" }

3 Connect the R8 to the computer.

( R& setup and connection )

4 Setup the DAW software.

[ Device setup

[l]%’ Reference: "Cubase LE Startup Guide" ]

(Control surface setup P.7

Mackie Control

| NOTE

The ZOOM R& audio driver is essential for
using the R& as an audio interface with DAW
software such as Cubase LE. (No driver is neces-
sary for use with Macintosh computers.)

- Download the latest IR& audio driver from the
Zoom Corporation website.
http://www.zoom.co.jp/

R8 setup and connection

Connect the R& to the computer
using a USB capable.

2 UB  Press USB.

Change
AUDIO I-F - menu
FERCEFR
D
Press ENTER.
4 Select .

AUDI0D INTERFACE Change
SETTING  [Cartinue =
EXECUTE

>

Press ENTER.



[ Disconnecting )
‘I Press the D below
USB

or press D
2 Select

Terminate Change

fire You Sure? o
YES =
NO
Press ENTER.

| NOTE

Select CONTINUE to use the same settings as last time.
© INSERT EFFECT settings

* SEND RETURN EFFECT settings

* Mixer settings

© TUNER settings

Select RESET to restore default settings for each item.

+ The audio interface and control surface func-
tions of the IR& can be used by drawing power
through a USB cable from the USB bus.

+ We recommend always using the latest IR&
system software.
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Using control surface functions

When using the R& connected by USB as an audio interface, the R& keys and faders
can be used to control Cubase LE’s transport and mixer.

About the control surface

Control surface setup

In control surface mode, the keys and knobs
on the R& can be assigned to particular
Cubase LE functions.

[ Transport section P8 ]
[ About banks P9 ]
[ Fader section P9 ]
| HINT

Assigning keys

For a list of functions that can be assigned to the
knobs and keys of the IR&, as well as other trans-
port/function keys that are supported by Cubase
LE, please consult the “Control surface functions
quick reference guide” in this manual.

Reference: Control surface functions quick
reference guide

P.12 }

{ see R8 setup and connection on P.5

5 Then, launch Cubase LE.

From the Cubase LE “Devices”
menu, select “Device setup...”

7 At the top left of the Device setup

window [+], [-] and [|<] buttons
appear. Click the [+] and select
“Mackie Control”

8 Set the MIDI input and output

MIDI input: ZOOM R8
MIDI output: ZOOM R8

J HINT

The display of MENU etc. may be different
depending on the version of Cubase LE.
Please refer to your Cubase LE manual.




Transport section

By setting up the control surface, the R8
transport section keys can be assigned to indi-
vidual functions in Cubase LE.

F1 key F2 key F3 key F4 key F5 key
MARKER ‘
AUTO HUNCH 170 A-B REPEAT l i MARK/lJEAR
R F2 | B ] F4 5]
STDP PUAY RE‘
REW key FF Key STOP key PLAY key REC key

Rewind fol:\?vs:rd Stop Playback Record

J HINT

You can connect a footswitch to the CONTROL IN
jack to start and stop playback, and change effect
patches, for example, with your foot when using the
R8 =5 an audio interface.

= Reference: Operation Manual -
[ Using a footswitch P13 }
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Fader section operation

Using the faders and status keys of the fader section, you can adjust the volume of
corresponding Cubase LE tracks, mute and solo them, and arm them for recording.

About banks

Operating the fader section

After setting up control surface operation, the
main parameters of Cubase LE can be oper-
ated using the R& fader and status keys.

A group of tracks operated by the faders
and status keys is called a “bank.” With the
R&8, one bank of 8 adjacent tracks can be
controlled.

For example, if fader 1 is assigned to Cubase
LE track 1, tracks 1-8 can be controlled as
shown in the following diagram.

B | 2 8|45 6 7 |8
Track ™1 T2 T3 T4 TS5 Tr6 T7 T8

As the diagram shows, when tracks 1~8 are
selected, pressing (J beneath IERTA once
switches the assignments as shown below.

B ' 2 8 |4 5 6|7 |8
Track ™9 10 Tr11 Ti12 Tr18 Tri14 Tr15 Tri6

Push D beneath lm:]m

The next lower bank of eight tracks (channels) is as-
signed to the fader section.

Push D beneath mﬂﬂ]

The next higher bank of eight tracks (channels) is
assigned to the fader section.

‘I Assign the Cubase LE tracks
(channels) that you want to control
to the fader section.

2 Use the faders to control the

volumes of the corresponding
tracks.

The faders control the volumes of their re-
spective tracks. Change the master volume
by moving the Master Fader.

3 To change the function of the

status keys for all the tracks,
press the soft key for the desired
function.

e .1
SUDI0 INTERFACE

Use these keys to set the
functions of the status keys



R8 level meters
(Audio interface use)

RE! 1.1
aUDI0 INTERFACE
Lo

-3
1ERHE | ERHER

Signal just before being Signal returning from
sent to computer shown the computer shown.

Checking DAW recording levels
. (in the
menu) to set whether signals
are sent to the computer {7 (with
effect) or “ =" (without effect).

prnpunpunpenpenpeepenpeny - Adjust so that the

mE-' T level meters do not
P clip (reach 0 dB).
s »
=48 -8 -2~k il
0dB
(clipping)

10
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1

Setting the function keys

The five keys above the transport keys can be used as function keys (F1~F5) and

assigned as desired.

Function key setup

Open the “Device setup...” dialog
in Cubase LE.

2 Select “Mackie Control”.

Commands can be assigned using the three
columns displayed on the right side of the
window.

3 From the “Button” column choose
the function key (F1~F5) to be
assigned a Cubase LE function.

Click on the “Category” column for
that control.

Choose the type of Cubase LE
function from the Category pop-up
menu.

Click on the “Command” column
and select the desired Cubase LE
function from the pop-up menu.

The items in this pop-up menu will differ
depending on the category chosen.

Press the “Apply” button.

J HINT

The display of MENU etc. may be different
depending on the version of Cubase LE.
Please refer to your Cubase LE manual.




Control surface functions quick reference guide

12
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13

Using Cubase LE template files

{ “XX” varies depening on the version installed.]

Create a new project

‘I Copy the ZOOM R& project templates
to the computer.

From the CubaseLE_template folder on the SD

card included with the RB, copy the templates
to the location where Cubase LE is installed.

Windows
The folder opened by clicking Start>Steinberg
Cubase LE XX>User Settings Data Folder

Macintosh
/Applications/CubaseLE XX.app/Contents/
templates/

2 Launch Cubase LE and select File
> New Project.
Depending on your settings, either
the Steinberg Hub or the Project
Assistant dialog opens.

plates to the designated folder, these project
templates will be displayed when creating a
new project. By choosing these templates
you will be able to easily create projects with
audio track input and output settings already
made for the R8.

3 If you have copied the IR& project tem-

Template names and details

ZOOM R8 Mono Recording

Project with Cubase LE mono tracks 1-2 assigned
to FR& INPUTS 1-2

ZOOM R8 Stereo Recording

Project with a Cubase LE stereo track assigned to

R&8 puts 1-2

Tips to improve performance

When using Cubase LE, application perfor-
mance could become extremely delayed or
error messages such as “cannot synchronize
with USB audio interface” might be dis-
played. Should such things happen often,
the following measures might improve the
situation.

@ Quit other running programs.
In particular, confirm that many background
applications are not running.

@ Reduce the use of plug-ins
(effects, virtual instruments)

in Cubase LE

If a large number of plug-ins are running, the
computer processing capacity might not be
able to keep up. In addition, reducing the
number of simultaneous playback tracks
might be effective.

If the sound breaks up, please increase the
audio Buffer Size (Devices > Device Setup...
> R8 driver > Control panel).

Moreover, if the application performance
is extremely slow and regular computer
operation is affected, we recommend quit-
ting Cubase LE and disconnecting the IR&
USB port from the computer once, and then
reconnecting the USB port and relaunching
Cubase LE.




Mixer in audio interface mode

In audio interface mode you can make a mix for monitoring using the R& internal
mixer. In addition, you can adjust the balance of the sound from the internal mixer and

from the computer.

Volume, reverb send, pan

Stereo link

You can be adjust the reverb send, pan,
volume and stereo link settings in the same

way as in recorder mode.
Operation is the same as in recorder mode.
(Reference: Operation Manual P.42)

PAN/EQ menu

VOLUME

Adjust the volumes of INPUTS 1-2.

0-127 (increments of 1)
Default value: 100

=

REV SEND

Adjust the reverb send levels of INPUTS 1-2.

Ineutl
PAH Lenter

REU SEHD (@
OLUHE
=T LIMK

0~100 (increments of 1)
Default value: 0

Reverb only affects the
monitored signal (as in

recording mode).

PAN (BALANCE)

Adjust the pan for INPUTS 1-2.

L100~R100
(increments of 2)
Default value: Center
(as in recording mode)

Link INPUT 1 and 2 to handle them as stereo
pairs.

Inputls2

On/Off

Default setting: Off

By setting up a stereo link, volume, reverb send and pan
track parameters can be shared by INPUT 1 and 2.
(Reference: Operation Manual P.29)

Balance

In audio interface mode, the balance of the
input monitoring signal and the signal from
DAW software (the computer) can be adjusted
with the BALANCE knob.

BALANCE
Left Right

Only the INPUT Only the DAW
1-2 signals stereo signal
MASTER CLICK

| NOTE

The reverb send, pan, volume and stereo link
settings are all saved when you end )
audio interface mode and can be used again the
next time.

14
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Tuner

The R& tuner can be used as when in audio interface mode. For details, see the
Operation Manual (P.108).
Chromatic tuner I HINT
TOOL > 7
» The default value of the standard pitch is 440 Hz.
TOOL + Tuners other than the chromatic tuner can also
] D Press TOOL. be used.

I Reference: Operation Manual

Tuner P.108

T["]L Change
TUHER . I NOTE

Tuner settings are saved when you end
dio interface mode and can be used again

mren, ™

‘ I Reference: Operation Manual

Tuner P.108

To change the standard pitch, To change the tuner type, press
press the D beneath EfA. the D beneath .

CHROMATIC TUNER

Change the
standard pitch

Change the
tuner type

15



Effects in audio interface mode

The R8 insert and send-return effects can both be used when the sampling frequency
is set to 44.1 kHz. Basic operation is the same but there are a few differences in the

menus.

Insert effect

Send return effect

As in recording mode, you can select the insert
location and the insert effect algorithm, as
well as the effect patches to be applied to the
signal being recorded.

INSERT EFFECT menu options

Select the insert location

When used as an audio interface, the send
reverb can only be used for monitoring
As in recorder mode, use the
menu to change the patch and use
menu to set the
level that adjusts the reverb depth.

Setting the reverb send level

Insert on any INPUT 1-2.

INSERT EFFECT

THSERT | REVERE

(Reference: Operation Manual P.45)

Apply the effect only to monitoring

The effect can be set to only be applied to the monitoring
signal and to not affect signals recorded in DAW software.

INSERT EFFECT

iHEEFiT FEVERE

(Reference: Operation Manual P.89)

LiGa

|@

PEN

(Reference: Operation Manual P.44)
(Reference: Audio interface manual - Mixer P26)

| NOTE

+ Effects can only be used when the sampling rate
is 44.1 kHz. At all other times they are turned
OFF.

+ Insert and send return effect settings are saved
when you end (; i) audio interface mode and
can be used again the next time.

16
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17

Working with patches

After making many changes, you can restore a patch to its pre-edited settings by
initializing it. This will return it to its factory preset condition.

Patch operations
For both insert and send return effects

Menus used for patch operations

Selecting patches
I ] i § :

Select a patch from an algorithm to use an
insert or send reverb effect.

(Reference: Operation Manual P83)

Editing patches (EDIT)

By adjusting effect module parameters and
levels, you can create the desired result.
(Reference: Operation Manual P84)

Importing patches (IMPORT)

All effect algorithms (and reverb patches) or
a single one can be imported from a selected
project on the R8.

(Reference: Operation Manual P.87)

In audio interface mode, one complete set of effect
data is saved for the mode. There are no project
based settings.

Saving patches (SAVE)

Edited patches can be saved.
(Reference: Operation Manual P.86)

Initializing patches (INITIAL)

Patches can be restored to their original fac-
tory settings. (This option is only available in
audio interface mode.)

Changing patch names (RENAME)

The name of the currently selected patch can
be changed.

(Reference: Operation Manual P.88)

Patch initialization (factory reset)

EFFECT >

EFFECT
] D Press EFFECT.

Selecting effect type

Insert effect

Press the D beneath FGHIA.

Send return effect

Press the

D beneath EHEAL

The following example is of an insert
effect.

Turn the effect i,
INSERT EFFECT

Select* )
PATCH INITIAL

Change

menu

Are You Sure? =
=
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Cubase LE Startup Guide

@ Install Cubase LE referring to the bundled @ Select "New Project" from the "File" menu.
' ' CUBASE LE
Download access code sheet'. @ DOWNLOAD INFORMATION

"Project Assistant" window opens in order to select a project template. Click "More",
select "Empty", and then click the "Create" button to display the project window.

Toguir of Cubase L5
Culbase LE dowslsad insluctions
— G

(- Cubase Elzments 7 - [Cubase Elments 7 Praject - Untitied 1 [
‘\' File Edit Project Audio MIDI Media Transport Devices Window Help Steinberg Hub & x

@ Download the latest driver from ZOOM website
(www.zoom.co.jp) and install it.

Connect the ZOOM unit to the computer. R
Please refer to Operation Manual how to connect. XXX XXX - XXHEX-XXHXK - XHXHK

(@ steinberg

Download access code sheet

@ Select "Add Track">"Audio" from "Project" menu and add new audio track.

Startup Cubase LE, select "Device Setup..." from the "Devices" menu, and click "VST audio s Ty
system" in the Devices Column.

@ Select the downloaded driver or the devices including the ZOOM model names here.
e.g. H Series Multi Track is shown as following.

. MIDI Port Setup

CLICES OFF

QISR TRACK
Select "VST Connections" from "Devices" menu and set the input and output device L SN T
@ ports to the downloaded driver or the devices including the ZOOM model names. / l \
For multi-track supported models, click "Add Bus" and add the input bus.
e.g. H Series Multi Track is shown as following.

Stop button Play button Record button

Recording starts. Click "Stop" button to stop recording.

@ Click "Play" button to check the recording.

ZOOM H Series Multi Track ASIO
:|DOM H Series MultiT... IN L L . )
JOOM H Series Multi T... IN R This is all for the basic setting.
Sterea \| ZOOM H Series Multi Track ASIO For more information, pl refer to the Documentation from "Help" in Cubase LE or
O M T T visit Steinberg website (www.steinberg.net/en/home).
ZOOM H Series Multi T...

The Menu items are subject to change. Please refer to the Cubase LE Operation Manual in such cases.
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